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Introduction 
o save time in the future, print a copy of this document. Choose Print from the File 
menu 

 

Getting Started: A Tutorial for Digitizing Images with 
SewArt 

SewArt is software for converting digital graphics images - which may be stored either in 
raster (bitmap) or vector format - to a stitch file that can be sewn on an embroidery machine. 
For a list of image formats that SewArt can read, see File Open. This process will be 
referred to as embroidery digitizing and the software for doing that (SewArt) is called an auto-
digitizer.  
 
It is advisable to familiarize yourself with the SewArt toolbar buttons. Most of the 
important operations for the conversion process are accessible by clicking these buttons. 
The key to obtaining a high-quality embroidery file is to first create an image comprised of 
uniformly-colored regions. For that reason, SewArt has numerous image-processing tools 
on its toolbar to help in creating images suitable for sewing. Such images will be called clean 
images. 
 
The steps below outline the general procedure for using SewArt to convert a digital image 
into an embroidery file. By clicking the following links in order, you can follow the step-by-
step process of image conversion, starting from an image file and ending with an 
embroidery pattern file. When using this help in such a tutorial fashion, remember to click 
on the Home symbol at the top right of each subtopic page to return to this main page and 
then proceed to the next step. 
 
Steps for converting a digital image to an embroidery file 
 

Step 1. From the File menu, click Open (or from the Edit menu, paste from the 
clipboard) to import the graphics image to be converted. You may also draw your own 
graphic image on the blank canvas. 

Chapter 
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Step 2. Use graphics editing tools to process the image to make it suitable for 
sewing. There are three groups of image processing tools: 
 
     
   A.   Size and position tools 

• Resize the image. This allows you to work with an image of the same size as 
the embroidery pattern size to be sewn. 

• Rotate the image (by 90-degree increments) if it is more conveniently viewed 
in a different orientation. 

• Crop the image if it has excessive white space around it. Working with a 
smaller image is usually easier. 

 
B.  Color reduction tools 
• Reduce the number of colors in the image. 
• Merge colors individually or in specified ranges based on the amount of area 

in the image covered. 
 
C.  Image editing tools 
All these tools can also be used in conjunction with the magnifier to allow editing 
of very localized regions of the image. 
• Use the paintbrush to fill small regions of isolated pixels or gaps in the image 
• Use the pencil to darken lines and fill individual pixels in the image 
• Bucket fill larger regions of the image to uniformly blend colors and avoid 

any fine-scaled (dithering) effects. 
 

Step 3. Save the edited graphic image to a file on disk 
 
Step 4. Convert the graphics image to stitches by clicking on the different color 
regions to be sewn, possibly using the auto-sew feature, and save the stitch list to an 
embroidery pattern file 
 
Step 5. Edit the embroidery file to join or reorder color blocks, or eliminate short 
thread runs (this can to be done with an embroidery editor, such as SewWhat-Pro©). 

 
 

Contacting Us 

If you have any questions or comments about the SewArt auto-digitizing application, please 
contact us at the following support email: 
 
 
support@sandscomputing.com 
 
 
Some frequently asked questions about SewArt are answered below: 

mailto:support@sandscomputing.com


 
 
 
 
S E W A R T  U S E R ’ S  G U I D E  

 5 

 
How can I tell if I have the latest version of Sew Art? 
Go to the Help/About menu item and compare the version there with the one that 
is available for download on our website. You can use to Update button to go to our 
website and check there for the most recent version. 
 
Can I install SewArt on more than one computer? 
Yes, the license grants you that privilege, as long as you are the sole user of SewArt 
on all the computers. 
 
How do I put a copy of SewArt onto a laptop that has no internet capability? 
Transfer the installer file (the file you downloaded originally) onto the laptop, using a 
USB or other transferable drive. Then double-click that file on the laptop and enter 
your registration information. Alternatively you can purchase SewArt on a CD. 
 
If my computer crashes, how do I get SewArt working again? 
You can always download a current version of SewArt from the S & S website at 
http://sandscomputing.com. Just download from the Update link there. In such a 
case, it would have been a good idea to keep a copy of your registration information 
in a separate, safe location. 
 
 

FAQ (Frequently Asked Questions) 
See “How To . . .” Topics in Chapter 10 
  
 

• Avoid Sewing the Background Color 
• Change the color of a painting tool 
• Change the fill pattern 
• Get help if you have questions about SewArt 
• Remove speckles to create an image suitable to be sewn 
• Resize or change the density of a design created by SewArt 
• Undo a previous operation 
• Use a "Blank Canvas" to draw your own images 

 

http://sandscomputing.com/
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Menus 
o save time in the future, print a copy of this document. Choose Print from the File 
menu 

 

File Menu Commands 
 
The File menu offers the following commands: 
 
New Creates a new blank sewing pattern file. 
Open Opens an existing sewing pattern file. 
Close Closes the presently active pattern file. 
  
Save Saves an opened image file, using the same file name. 
Save As Saves an opened image file to a specified file name. 
  
Exit Exits the SewArt application. 

 

 

Edit Menu Commands 
 
The Edit menu offers the following commands: 
 
Undo Reverse (undo) previous editing operation. 
Paste Pastes an image from the Windows clipboard into the SewArt workspace.  
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View Menu Commands 
 
The View menu offers the following commands: 
 
Grid Displays a grid over the image 
  
Magnify Magnifies around a selected region of the image 
Zoom In Magnifies image on screen 
Zoom Out Shrinks image on screen 
  
Main Toolbar  Shows or hides the main toolbar. 
Status bar Shows or hides the status bar. 

 

 

Image Menu Commands 
The Image menu offers the following image-manipulation commands: 
 
Rotate Rotate image in 90-degree increments 
Crop Remove unwanted areas of an image for easier editing. 
Resize Resize image to width of desired embroidery pattern 
  
Reduce Colors Reduce number of distinct colors in image 
Merge Colors Merge individual colors in the image 
  
Paint Brush Blends existing colors 
Pencil Fills in single pixels or lines 
Fill Region Fills in a large region with a uniform color 
  
Convert to Redwork  
Convert to Stitches Converts the graphics image to an embroidery pattern file 

 

Options Menu Commands 
The Options menu offers the following commands for setting project options: 
 
Units Choose to use metric or Imperial units of length 
Parity Choose between left- and right-handed tool icons 

 



 
 
 
 
S E W A R T  U S E R ’ S  G U I D E  

 8 

 

Window Menu Commands 
The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:   
New Creates a new window that views the same document. 

deCasca  Arranges windows in an overlapped fashion. 
Tile 

ows 1, 2, ...
Arranges windows in non-overlapped tiles. 

Wind  

 

mmands, which provide assistance for using SewArt:  

Help topics

Goes to specified window. 

 

Help Menu Commands 
The Help menu offers the following co
 

 Offers you an index to topics on which you can get help. 
rtAbout SewA  

ion
Displays the version number of this application. 

Order Informat  f this software. 
 

 

Describes how to order the commercial version o
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File Menu 
se these menu items to open and save both image files and sewn embroidery files. 

 

File New 
Use this command to create a new document workspace for opening a new blank 
canvas.  You can open an existing image with the Open command. 

 

File Open 
Use this command to open an existing graphic file in a new window. You can open 
multiple files at once, and each will occupy a separate window. Use the Window 
menu to switch among the multiple open images.  

 
SewArt will allow you to open several raster file types (*.bmp, *.png, *.jpg, *.gif, *.tif) as well 
as vector formats (*.emf, *.wmf).  When you use this command, SewArt displays a file open 
dialog so you can select the pattern file(s) to open. 
 
Alternatively, you can open an existing document by selecting it from the most recently used 
(MRU) file list in the File menu, if it was recently opened.  
 
The figure below shows the image file Chubby Penguin.jpg after it has been opened by SewArt. 
(This image is used here with permission from Clipartpolis). The image is surrounded by a 
bounding rectangle which shows the editable region of the image. We have a chosen a (raster) 
JPG file because it illustrates many of the necessary image reduction features that SewArt 
can apply. Beginning users might want to consider simpler vector graphics files that are 
available for free download - and without copyright restrictions - from several websites. 
They will require less image manipulation to produce a suitable image for sewing. 
 

Chapter 
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On the right of the SewArt workspace is the Information pane which displays the image 
dimensions (265 mm X 265 mm for this example) and the number of colors initially present 
in the image. Automatic color reduction to 256 or fewer colors is done by SewArt when the 
file is opened. 
Note the vertical and horizontal scroll bars that appear automatically when the image size is 
larger than the active workspace. These are used to move (scroll) to a part of the image that 
is not visible on the screen. The scroll bars will disappear whenever the image size is equal 
to, or less than, the workspace dimensions. The actual image may be resized (which is 
recommended) to the desired size of the final pattern. Also, the screen size of the image can 
be changed by using the magnifier glass or the Zoom In/Zoom Out tools on the toolbar. 
 
If you have a graphics file in a format that is not currently supported by SewArt, you can 
still import it into SewArt by using the Edit menu paste command. For example, you may 
use MS Paint® to open a TIFF file, select it, and then copy it to the clipboard at which time 
it can be pasted into an empty SewArt workspace. 
 
You can create a new blank workspace with the File New command. 
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File Close 
Use this command to close all windows containing the active document. SewArt 
suggests that you save changes to your document before you close it.  If you close a 
document without saving, you lose all changes made since the last time you saved 

it.  Before closing an untitled document, SewArt displays the file save-as dialog and suggests 
that you name and save the document. 
 
You can also close a document by using the Close icon on the document's window. 
 
 

File Save 
Use this command to save both image files and stitch files. Which one gets saved 
depends on the active mode of operation of SewArt at the time the Save 
command is issued. 

 
 

1. For any SewArt mode except the stitching mode, Save will write the edited image to 
either a compressed image (png) file or a Windows bitmap (*.bmp) file.  When you 
save a document for the first time, SewArt displays the File Save As dialog so you 
can name your image file and select the type to save to.  
 
2. When SewArt is in Stitch Mode, Save will write the stitches you have created to an 
embroidery pattern file. You may choose from one of three popular file formats 
Brother® (*.pes), Janome® (*.jef) or Singer®  (*. xxx): (This can be converted later 
in an embroidery file editor to whatever convenient format you need.) Along with 
this embroidery file, a file containing the stitch list information will also be saved 
with the extension *.saf. When you reopen the image file at some later time, the 
previous stitch listed can be loaded, too. The first time that Save is used from Stitch 
Mode, SewArt will display a special form of the File Save As dialog to allow you to 
choose the name for the pattern file and select its format and its size (if it should be 
different from the image size). 

 
 

File Save As 
In SewArt, the Save As command performs a dual role, depending on the active mode at the 
time the command is issued. 
 

1. When SewArt is in any mode except for the Stitch Mode, use this command to save 
and name the image as either a compressed image file (*.png) or a Windows bitmap 
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(*.bmp) file.  SewArt displays the standard file save-as dialog box so you can name 
your image file and select its file type. It is strongly recommended to save 
using the *.png (portable network graphics©) format, which compresses 
the file by as much a 100 times, compared to the *.bmp bitmap format. 
 
2. When SewArt is in Stitch Mode, use this command to save and name the stitch 
pattern file (see the dialog below). Both the File name and its type (*.pes, *.jef, or 
*.xxx) can be set here. In addition there are two further options that effect how the 
pattern file is saved: 
 

• specify a Design Scale Factor for scaling the pattern file relative to the image 
file. The pattern size will be displayed next to the box where you enter this 
numerical factor. A value larger than 1.0 will create a pattern file larger than 
the image file, and vice versa. 

• specify the minimum number of stitches in a color block that SewArt will 
sew out to the pattern file. The default is 4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To save an image or a pattern file with its existing name and directory, use the Save 
command. 
 

 

File Exit 
 

Use this command to end your SewArt session.  You can also use the Close 
command on the application Control menu.  SewArt prompts you to save 
documents with unsaved changes. 
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Edit Menu 
se these menu items to Undo image editing operations and to paste images from the 
Windows clipboard into SewArt. 

Undo 
Use this command to reverse the last editing action, if possible. Important: The 
Undo command is dimmed on the menu or toolbar (it is unavailable) if there are no 
actions to reverse or if you are in Stitch Mode. In SewArt, the following operations 

may be undone (the last several - usually up to 10 - operations can be reversed this way): 
 

Undo Operation Effect of Undo 
  

Rotate Rotate image back by -90 degrees 
Resize Restore image to previous size 

Reduce Colors Restore previous number of colors 
Merge Colors Restore color state prior to merge 
Paint Brush Erase last paint operation 

Pencil Erase last pencil click (or line drag) 
Bucket Fill Erase last filling operation 

  
 
Type Ctrl-Z as a short-cut for this common operation. 
 

Paste 
Use this command to insert a graphic of an image that was copied to the clipboard 
from another application (like MS® Paint).  This command is unavailable 
(dimmed out) if the clipboard is empty or if there is already an image in the 

workspace. 

age from a file type that is not supported by 
ewArt into an empty (new) workspace. 

 

 
This command may be used to copy an im
S
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View Menu 
se these menu items to help view the images in various formats and sizes in SewArt. 

 

Grid 
When checked, this command displays a grid on top of the image. The spacing between grid 
lines is about 4 pixels. In the tutorial figure below, the penguin image has been magnified 4X 
and the grid option has been checked. The presence of the grid is useful for editing 
individual pixels or regions of an image with the Paint Brush or Pencil tools, and for drawing 
lines to fill-in borders and boundaries. 
 
The grid is drawn on top of the image on the screen and will not be sewn. 
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Magnify 
 

Left-click on this tool to magnify ("zoom-in") the size of the image displayed on 
the screen while keeping the part of the image under the glass always visible on the 
screen. Right-click to reduce ("zoom-out") the image size on screen. 

 
The active state of this tool is toggled: if you click the magnifier icon on the toolbar once, it 
will remain active until you click it a second time to deactivate it. 
 
This is useful for editing individual pixels or regions of an image with the Paint Brush or 
Pencil tools. 
 

Zoom-In 
 

Click this toolbar command to magnify the size of the image displayed on the 
screen. This is useful for editing individual pixels or regions of an image with the 
Paint Brush or Pencil tools. 

 

Zoom-Out 
Click this toolbar command to reduce the size of the image displayed on the 
screen.  
 

 

Main Toolbar 
 
Use this command to display and hide the main Toolbar, which includes buttons for some 
of the most common commands in SewArt, such as File Open. A check mark appears next 
to the menu item when the Toolbar is displayed. It is checked by default. 

ppears next to the 
menu item when the Status Bar is displayed. It is checked by default. 

 

Status Bar 
Use this command to display and hide the status bar.  A check mark a
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Title Bar 
The title bar is located along the top of a window.  It contains the name of the application 
and document. To move the window, drag the title bar.  Note: You can also move dialog 
boxes by dragging their title bars. 
 
A title bar may contain the following elements: 

• Application Control-menu button 
• Document Control-menu button 
• Maximize button 
• Minimize button 
• Name of the application 
• Name of the document 
• Restore button 
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Image Menu 
se these menu items to apply various image-processing methods in SewArt. 
 
 
 

Crop 
Use this toolbar command to crop (remove) parts of the image that are not desired.  
For example, if there is a white space around the image that is not to be sewn, it can 
be cropped with this tool. 
 

After clicking this toolbar button, a moveable and resizable cropping-rectangle will appear 
surrounding the image. Drag the corner or side handles to resize the rectangle, and click 
inside it to move it to the desired position. When the part of the image you wish to retain 
appears inside the cropping rectangle, press the Crop Image button in the Information pane to 
perform the cropping operation on the image. If the cropped image is not what you wanted, 
press Ctrl-Z (or click the Edit/Undo menu item) to reverse the cropping operation. Exit the 
cropping mode by clicking the Cancel button. 
 
The tutorial example shown in the figure below shows the cropping rectangle (dashed line) 
around the original image. The width of the cropping rectangle has been reduced to fit 
tightly around the image and, when the Crop Image button is clicked, it will eliminate that 
white space around the image.  
 
At this point, it is advisable to Save the edited image file. Since cropping has reduced the 
image width from 130 to 110 mm, we save it to a compressed image file called 
Penguin110X130.png. 
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If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main page. 
 

Rotate 

Use this toolbar command to rotate the image in 90-degree increments for easier 
viewing. For the tutorial example, the rotated image is shown in the figure below. 
Since this is not the preferred rotation, pressing Ctrl-Z (or click the Edit/Undo 

menu item) restores the original vertical orientation of the image. 
 
If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main page. 
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Resize 

Use this toolbar command to open a dialog (shown below) for resizing the image. 
This is a useful option if you want to work in SewArt with an image of 
comparable size to the final stitched pattern. 

 
 

 
 
 
 
The present size of the image will appear initially in the Width (265 mm for this example) 
and Height (265 mm) boxes. Edit these by entering the desired sizes for the image (in mm). 
If the Lock Aspect Ratio option is checked, then you only need to edit one or the other of  
these items and the other will be updated to keep the original height-to-width ratio (the 
aspect ratio of the image). 
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If you wish to return to the previous size, press Ctrl-Z to Undo this operation. 
 
If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main tutorial page. 
 

Wizard 
 

Use this toolbar command to enter Wizard mode. This starts the image-processing 
wizard to guide you through the steps to convert the image into a form amenable 
for a high-quality stitch-out. 

 
The basic principle of the Wizard is to choose various values (color numbers, despeckling or 
merge percentages) in a way that will both reduce the color number and preserve the image 
integrity. There are up to eight selections per page. To leave the image unchanged click the 
"Original Image" radio (selection) button and then proceed to the next Wizard page. 
 
Each page of the Wizard (after the introduction) allows you to perform a different image-
processing operation as noted in the caption title bar. The Wizard has navigation buttons at 
the bottom of each page to allow you to proceed to the next page (the Next button), to 
return to a previous page (the Back button), or to Cancel the Wizard and return to the main 
SewArt screen. Note that any operations performed in the Wizard mode may be undone 
when you have returned to normal mode. 
 
There are 4 steps (distinct types of processing) performed by the Wizard and described 
below. At each step you may choose from one of up to 7 reduction values (including the 
option to keep the unprocessed image). The choice is guided by the basic principle stated 
above: try to choose the value closest to the end of each list (which produced the biggest 
image processing effect) which leaves the visual integrity of the image intact. 
 
 
Step 1: Color Reduction 
 
The Wizard dialog for this case (we use the Penguin bitmap example, with 246 colors 
initially, throughout this discussion) is shown below: 
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After reducing the color number a few times (to 30 colors), one arrives at an image which is 
no longer acceptable (see figures below). 
 
 

 
 
 
Note that the two-tone color of the penguin bill has disappeared. So the “61 colors” button 
was clicked, leading to an acceptable image. The Next button was then clicked to proceed to 
the next page of the Wizard. (NOTE: the color numbers shown on this dialog depend on 
the number of initial colors in the image. Also, the color numbers specified are only target 
values and the final reduction is only guaranteed to be equal to or less than the number 
clicked. In this case, the “61 colors” option was clicked to yield 56 colors in the processed 
image. If the Back button would be clicked from the next page, the color numbers would 
then be based on 56 colors and not the original 246.) 
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Step 2: Merge Colors 
 
The Wizard dialog for this case is shown below: 
 
 

 
 
 
In this case, the list of percentages represent the fractional coverage in the image required 
before a color will be merged. The 0.40% button was clicked, indicating that colors that 
cover no more than 0.40% of the image area were merged. Even with this small percentage 
coverage, the image deteriorated so that it was unacceptable (see Figure below): 
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In particular the merge from 56 colors to 15 colors leaves most of the image intact but the 
outline of the bill began to disappear. (Note that the apparent discoloration of the cap is due 
to reducing the size of the figure and does not actually occur in the full-size image.) Thus, 
the 0.20% button was clicked to maintain the image integrity, while reducing the color 
number to 20. 
 
 
Step 3: Remove speckling 
 
The Wizard dialog for this case is shown below: 
 

 
 
 
In this case, pressing the lowest available color coverage fraction (1.56%) already produced 
an unacceptable image (see below), where the thin dark contours were broken up by the 
despeckling operation: 
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This is unusual and due to the graininess of the thin, dark outline contours. A much more 
typical case would be for a substantial color fraction (50-100%) to be despeckled without any 
noticeable degradation of the image. For this case, the thin outline colors were individually 
merged once the image-processing Wizard completed. Therefore, It was necessary at this 
step to click the "Original Image" radio button on the present Wizard page and then move 
to the next and final Wizard page. 
 
 
Step 4: Final Image Processing 
 
The Wizard dialog for this case is shown below: 
 
 

 
 
 
 
This final step presents the opportunity to do a "clean-up" of any remaining small-coverage 
colors. In this case, clicking the 0.78% button gave an acceptable image with a further color 
reduction to 12 colors: 
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While most of the solid black outline is preserved by this final processing, some of the 
outlines in the cap seem to break up. We nevertheless chose to accept this reduction (by 
clicking the "Finish" button). Once the Wizard was finished, we were able to merge a thin 
layer of yellowish pixels from the merge dialog, thus recovering the black outlining in the 
cap. If this had not been possible, we would have undone (Ctrl-Z) this last processing step. 
 
Once you have finished these Wizard steps, you may want to view the individual colors of 
the image in the Merge utility. In particular, make sure all the speckling has been removed, 
before trying to sew out the image. 
 

Reduce Colors 
 

Use this toolbar command to reduce the number of distinct colors in the image. 
The color reduction is done through the same sophisticated color quantization 
process that SewArt uses to reduce the potentially 16 million image colors (in a 

32-bit display) to only 256 when the image file is opened. This tool, in conjunction with 
color merging, provides the capability to smooth small-scale color variations in the image 
which would be very difficult to sew-out well. 
 
Why is color reduction important when converting an image to stitches? Below is a 10-fold 
magnification of the tutorial file penguin130X130.png (which originally had 246 distinct 
colors). Many of these colors are barely distinguishable shades of the seven or eight different 
solid colors that are clearly visible in the (unmagnified) image. For example, note the various 
shades of blue in what appears to be a solid blue region, particularly at the boundaries 
between the blue and the other colors. If each of these shades were stitched as a separate 
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color, there would be many small, disconnected regions. That will lead to a very low quality 
embroidery stitch-out. The goal of the color reduction tools in SewArt is to reduce these 
small variations and create a solid region that can be sewn in a single color shade without 
distorting the visual appearance of the image. 
 
 

 
 
 
When the Reduce Colors toolbar button is clicked, the Image Color Reduction dialog box appears 
(see the figure below). Enter the desired number of colors for the image in the edit box. In 
this example, the initial 246 colors were changed in a series of steps. (In order to maintain 
the appearance of the image, it is best to reduce the colors in steps.) Typically, halving the 
number of colors is a good way to proceed. In this case, the image color number was 
reduced from 246 to 128 to 64 to 32, without any substantial change in the image 
appearance. Reducing the colors to 16 removed the variation of orange colors on the 
penguin's beak, so Ctrl-Z (undo) was entered to restore the color number to 29 (for this 
image, SewArt reduced the color number to 29 even though 32 were requested). 
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It is interesting to ask: what happened to the other 217 colors? They have been color-merged 
("quantized") with the remaining colors to form the remaining visible, approximately solid 
color regions. As noted above, this reduction is important for the eventual uniform sewing 
of the image. 
 
If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main page. 

 

Merge Colors 
 

Use this toolbar command to further decrease (after applying the reduce color tool) 
the number of distinct colors in the image by merging colors that are very close to 
each other in appearance (i.e., close in Red-Green-Blue color space). This dialog also 

has a despeckle button which removes speckles (scattered, generally unconnected points). 
An example of image despeckling, and how it differs from color merging, is presented in the 
speckle removal topic. 
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When the merge toolbar button is clicked, a list of all the colors appearing in the image will 
be presented in the Merge Mode pane (just below the information pane on the right of the 
SewArt workspace). Under each button is the percentage of the image area covered by each 
color. See the figure below. 
 
 

 
 
 
The merge and despeckle buttons are disabled until you click one of the color buttons. 
When you click on a color button, the part of the image covered by that color is highlighted. 
(Note: this is a toggle operation - if you click the same color button twice in a row, the 
original complete image will reappear.) In the figure below, first the orange color was clicked 
(5.97% coverage, left side of figure), corresponding to the penguin's lower bill, mouth and 
feet, and then the yellow color (1.31% coverage, right side of figure), corresponding to the 
penguin's upper bill. Obviously these are solid color features which should be retained as 
part of the image to be sewn: that is, they should not be merged since they are distinctive 
features of the image. 
 
The remaining orange and yellow color stops display very low coverage percentages. Clicking 
on the 0.08% (left) and 0.17% (right) orange buttons will show a barely discernable, diffuse 
pattern of scattered points that tend to follow the outline of the well-defined features in the 
figure. Such points arise because of the imperfect color quantization of a real JPG image and 
would generally be absent in vector forms of clipart. (They are not shown here because they 
would not be visible at this resolution). These speckles, or diffuse unconnected points, would 
clearly not contribute to an image that would sew smoothly:  the needle would have to jump  
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from one unconnected point to another, which is clearly undesirable. They should therefore 
be discarded by merging them with the higher-percentage colors. The process of removing 
speckles is called despeckling. It can be accomplished by clicking the Despeckle button. When 
a particular color button has been previously clicked, then only the highlighted color will be 
despeckled. Otherwise, the despeckling operation can be applied to a range of colors in the 
image (by clicking the Despeck(le) Range button). If the result of despeckling is 
unsatisfactory, it can be "undone" by clicking the Undo toolbar button.  
 
Many of these low coverage speckles may be eliminated by clicking on a color button that 
you want to merge. Once a color button has been clicked and the Merge button activated, 
clicking the Merge button will perform the merge operation and the number of colors will be 
reduced by 1. Also, the color button will become inactive (dimmed) corresponding to the 
elimination of that color from the pattern. If for some reason the effect of this merge is 
unacceptable, immediately enter the Ctrl-Z key combination to Undo the merge and return to 
the previous color state. 
 
If you desire more control over which color the chosen one is merged with (Merge will 
automatically determine the nearest color in RGB space to the selected one), you can hold 
down the Shift (or Ctrl) key when you click the color button to be merged. Then, the next 
color button that is clicked will be the one that is used for the merge. This extra control 
might be useful in the following circumstance: suppose one of the colors consists largely - 
but not entirely - of a solid region, but has some speckles as well. This is fairly typical, with 
the speckles following a boundary between two colored regions of the figure. Then, you 
could use the Bucket Fill tool to fill the solid region with a slightly different color. When 
Merge Mode is entered, you will have two color buttons of nearly the same color, one with a 
relatively high percentage coverage (corresponding to the solid region that was just bucket-
filled) and one with a low percentage coverage corresponding to the speckles that you wish 
to merge. Hold down the Shift key and select that speckle color button and then click on a 
color (usually black, but not always) corresponding to the solid boundary that you wish to 
merge the speckles with. Note that a simple Merge button click would not have worked in 
this case: it would have simply re-merged the speckles with the solid color region! 
 
 
A powerful technique to eliminate an entire group of speckles is by choosing the Merge Range 
option. This will open the Color Merge Range dialog : 
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All colors with an image coverage below the specified percentage will be merged when the OK 
button is clicked. The default value (shown here) is 0.5%. In the tutorial example, using this 
value causes parts of the black outline to disappear, which is unacceptable. Experimenting a 
bit (using Undo to restore colors), we found that 0.3% works well for this example. This 
leads to a color reduction from 29 colors to 8 colors, as shown in the figure below. Note that 
the buttons for all the colors that have been merged are now disabled (that is, you can no 
longer click on them) and are labeled with 0% coverage. 
 

 
 
 
When you have completed the merge operations, click the Merge button again to exit from 
Merge mode. At this point in the image editing process, it is advisable to Save your changes, 
possibly renaming the file at the same time so you have a record of all the changes made. 
 
Note that the background color (white in this case) takes up over 60% of the area of the 
figure, even though we have cropped the image to minimize the background. Part of that 
color covers the white vest of the penguin figure. It is good practice to use the paint-bucket 
tool to fill the true background (the part of the pattern that you do not want to sew, the so-
called transparency color) with a distinct color, to distinguish it from the image colors that are to 
be eventually sewn as part of the embroidery pattern. This also allows you to use the auto-
stitch feature (see image conversion) without stitching the background. 
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If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main page. 
 

Paint Brush 
 

Use this toolbar command to draw on the image with a colored brush. After 
pressing this button to activate Paintbrush Mode, the cursor will change to a paint 
brush whenever your mouse is over the image. The paint brush tool options will 

appear in the tool pane (see the figure below). To select the brush color, control-click on a 
region of the image, or on the color palette bar at the bottom of the SewArt workspace (see 
figure below). You may also click on the eye-dropper tool and drag over the image and click on 
the desired brush color.  
 
 

 
 
 
Hold down the left mouse button while dragging the brush to blend that color into the 
region of the image. The tip of the brush is the hot spot where the drawing occurs The width 
of the brush can be chosen by clicking on one of the line-width buttons. Note that the size 
displayed on the screen for the brush width will depend on the magnification (zoom) that is 
in effect during the blending procedure.  
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You may also select different properties for the brush operation, including free-hand strokes, 
constrained line brushing or filled rectangle or elliptical brushing. These latter brush 
operations are useful for filling larger areas in a single click, and for drawing figures on a 
blank canvas. The usual application of this command is to fill in gaps or blend small regions 
with the dominant color of the chosen brush color. You may reverse a paint operation by 
pressing Ctrl-Z to Undo it. 
 
To exit Paintbrush Mode, re-click on the paint brush toolbar button or any one of the other 
available toolbar buttons. 
 
Useful hint: 
It may be easier to see the region being drawn if you choose the "inverse" color option. The 
brush strokes will stand out against the blended color background. When you are finished 
drawing with the inverse color, exit from paint mode and open the bucket tool to fill the 
inverse color with the correct color. 
 
If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main page. 
 

Pencil 
Use this toolbar command to draw individual points with a colored pencil. After clicking 

this button to activate the pencil drawing mode (see figure below), hold down the Ctrl key 
and click on a region of the image, or click on the color palette at the bottom of the SewArt 
workspace screen, to select the pencil color. You can also use the eye-dropper icon to select 
a color. Either click the left mouse button to draw individual points with this color, or drag 
the pencil to draw a line with the chosen color.  
 
The default width of the pencil is one pixel. Its appearance on the screen depends on the 
chosen magnification zoom level.  You may click one of the line width buttons to create a 
pencil up to 8 pixels wide. When using the pencil tool, it is convenient to magnify the region 
being edited until individual pixels can be viewed. 
 
Drawing with the pencil can be done either in free-hand mode, or in one of the constrained 
modes used to create straight lines, rectangular or elliptical outlines. 
 
The usual application of this command is to fill in individual points (isolated outliers) with the 
dominant color of the chosen region, or to straighten and/or thicken lines in the image. 
When drawing on the blank canvas, the pencil is useful for free-hand sketching or drawing 
lines and outlines. The pencil complements the paint brush and can be used where very 
small (pixel-size) details of the image need to be adjusted. To erase lines entered with the 
pencil, press Ctrl-Z to Undo the last drawing operation. 
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To exit Pencil Mode, either re-click the pencil toolbar button or click one of the other available 
buttons on the toolbar. 
 

Bucket Fill 
 

Use this toolbar command to uniformly fill a region with a solid color. After 
clicking this button to activate Fill Mode, you may choose the fill color in several 
ways (see the figure below): 

 
 

1. Click the eye-dropper icon and drag the resulting cursor with your mouse onto the 
part of the image containing the desired color. Click that region with the eye-dropper 
cursor to select that color for the fill. 
2. Hold down the Ctrl-key and click on the color in the image to use for the fill. 
3. Click on one of the pre-defined palette colors appearing at the bottom of the 

workspace screen. 
4. Create your own custom fill color using the hue-saturation-luminance (HSL) picker 

tool. Drag the little square to a part of the Hue-Saturation square and then adjust the 
luminance slider. The resulting RGB color value will appear below the square. 
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In either case, the bucket fill color will appear below the Color Matching Tolerance slider (which 
will be described below). To reverse a recent fill, press Ctrl-Z to Undo it. 
 

 
 
The simplest application of the bucket fill tool is shown in the figure above. After selecting 
the fill color using method #3, the bucket cursor (which automatically changes to a bucket 
when you move the mouse over the image but is not shown here) was moved over the 
background area of the image. Then the bucket was clicked to "pour" the tan fill color into 
the background. This is one way to distinguish the background area of the image which 
generally is not to be sewn from regions in the image (like the white vest of the penguin) 
that should be sewn. This same method may be used to change one or more of the image 
colors. 
 
An advanced application of this command is to fill (blend) small color variations within a 
relatively large region of the image where paint-brushing may be too slow or prone to error 
(for example, at the boundaries of the region). Typically this would be done after color 
reduction and color merging were already applied to the image. This blending effect requires 
that you select a non-zero blending tolerance. Move the color matching tolerance slider from 0% 
upwards (gradually) towards 100%, then click the bucket tool in the desired region. 
Gradually increase the tolerance percent until the bucket fill yields the desired degree of 
blending. Increasing the tolerance too much will cause the bucket fill to bleed into adjacent 
areas. If this undesirable effect occurs, then press Ctrl-Z immediately to recover the previous 
unblended state. 
 
An example of how "tolerance-assisted" filling can perform color-smoothing is shown below 
(this is not taken from the tutorial example which has no regions demonstrating this effect): 
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The top image is a blown-up region of a GIF file. Note the cross-hatching (dithering) in the 
brown region, which is undesirable for stitching since it would cause a tremendous amount 
of jumping from one thread location to the next. The bottom image was obtained using the 
bucket tool, using the following steps: 1) the eye-dropper was dragged over the top image 
and the desired brown color was selected; 2) the tolerance slider was incremented up to 40% 
(this was determined by trial and error - it may be a different value for different images); and 
3) the bucket tool dragged over the same area and clicked. Note that now all the very small-
scale color variations have been removed, and the brown region would now be considered 
suitable for stitching with SewArt since it is uniformly filled with a single solid (brown) color. 
 
Bucket fill blending is sometimes a useful alternative to color reduction, at least for small 
regions of the image. The figure below shows the effect of bucket filling on the original 246 
color tutorial image, without (left) and with (right) tolerance blending. On the left, the 
(default aqua) bucket fill tool was clicked on the right part of the penguin's beanie with the 
blending tolerance set to zero.  (It has been recolored to aqua for purposes of this tutorial, 
but in practice the fill color would be the original wine-color.) Note that the fill is irregular 
since there are small-scale variations in color of the original image (before color reduction 
and merging were applied). This shows very clearly why some form of reduction or blending 
is required prior to sewing the image: otherwise the irregular (aqua) colored region would be 
stitched rather than the desired smooth full upper 1/3 of the beanie. 
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On the right of the figure is shown the effect of bucket filling after setting the tolerance to 
20%, and then clicked the bucket tool on the same region again. Now the entire 1/3 part of 
the beanie has been uniformly filled with the same solid color. As a result, this region is ready 
to be stitched. 
 
To exit Fill Mode, re-click the bucket toolbar button or click one of the other available 
toolbar buttons. 
 
If you are using this help as a tutorial, click on the Home button (upper right) to return to 
the main page. 
 

Convert To Redwork 
 
Use this toolbar command to convert the image to a redwork outline, that can be 
saved to an embroidery file by later clicking the convert to stitches button. When 
you click this button, the options menu shown below will pop-up: 

 
 

 
 
 
You can choose Outline to convert a filled image into outline stitches. Choose the Centerline 
option if the image is already outlined. Note that this option will preserve (and thin down to 
a single pixel) existing outlines in the figure. For example, if you have created a stick-figure  
using the drawing tools in the Blank Canvas, you would want to use centerlining to convert 
the image to an outline. 
 
After selecting the appropriate option, the image will be automatically converted to outlines 
or center-lines. The resulting "redwork" image can be edited with the pencil or paintbrush 
tools to either remove unwanted segments of the drawing, or to add to (or connect existing 
parts of) the image. When you are ready to save the redwork image to an embroidery file, 
click the Convert to Stitches toolbar button to open the outline toolbar. 
 
If you want to create your own redwork image from a blank canvas, then you should click 
this button before beginning to draw. This will avoid splitting single thin lines into parallel 
pairs of lines. 
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Convert to Stitches 

Use this toolbar command to convert the image to stitches which can be saved to an 
embroidery file in one of three popular file formats: Brother® (*.pes), Janome® (*.jef) or 
Singer® (*. xxx). 
 
When you click this button, the Stitch Toolbar will appear and become active, indicating that 
SewArt has entered Stitch Mode. With this toolbar you control properties of the stitches in 
any region of the image that you want to sew, including the stitch angle, presence or absence 
of underlay, fill pattern and stitch length. (If the image is a redwork image, then you can 
select the type of outline stitches to use. The remainder of this topic describes the steps 
needed to convert a filled image to stitches.) Presently SewArt supports only a satin stitch 
for filling the image. However, you can choose from a variety of pattern fills as described 
below. You may set these properties from the toolbar and/or edit them in the stitch list after 
the image has been sewn. Also, the cursor will change to a "sewing needle" when you are 
over the image. If you have previously sewn and saved this image and have reopened it,  you 
will be asked if you want to import the existing stitch list. If you answer "yes," all the stitches 
from the previous session of SewArt for this file will be restored. You can clear the current 
stitch list by clicking the Clear Stitches button. This operation cannot be undone. 
 
Follow the steps below to perform the actual conversion of the digital image to an 
embroidery pattern file. Refer to the figure below as needed. It shows SewArt in Stitch Mode, 
and the associated color stops entered into the stitch list (the right tool info pane).  
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You may end a sewing session at any time by clicking the End Sew Mode button. If you have 
not saved the stitches to a file, you will be asked to do so at that time. Even if you decline, 
the stitches will be retained in memory for the current session of SewArt, so these stitches will be 
retrieved the next time you enter Stitch Mode but before closing this work session. However, 
the stitches will be permanently saved only if you decide to save them before closing SewArt.  
 
There are just two steps involved in converting the image to into stitches that are saved in an 
embroidery file: 
 
1. "Stitch" the Image (on screen) 
The process of converting the image to stitches is very simple in SewArt. You can choose 
between completely manual stitching (which gives you the most control), auto-sewing an 
entire color, or auto-sewing the entire image. These options are described here: 
 

1.    Manual stitching: click on a region of the pattern that you want sewn. The 
point you click - the seed point - will show up as a colored rectangle on the screen. 
You will be prevented from later re-clicking on the same region (unless you have 
chosen the delete or resew option, see below). 
2.  Auto-sew Color: click the Auto-sew Color check box on the toolbar. Then click a 

color and all disconnected regions of the image with that color will be sewn 
3. Auto-sew Image: click the Auto-sew Image check box on the toolbar. A drop-

down menu will appear with a choice to sew all colors (including the 
background) or to choose a transparency color that will not be sewn. Once you 
made this selection and chosen the transparency color if required, stitching of the 
image will begin automatically.  

 
Important Note: use the auto-sew options with some care. Unless the image is clean 
(in the sense that it contains few outlier points), auto-sew could take considerably 
longer than manually clicking on the individual color regions. If there are numerous 
outlier points - which are barely visible and which make a negligible contribution to 
the image quality - the auto-sew option will nevertheless have to check each of those 
points. 
 
You may want to edit certain features of the auto-sewn pattern before saving it - see 
the section below that describes how to edit the stitch list. 

 
 
2. Save the Embroidery Pattern and Stitch List 
Click the Save button on the main toolbar to write the contents of the stitch list to an 
embroidery file. This will open a File Save As dialog for you to enter the file name if the file 
was not previously saved in this session. There is an option to enter a scale factor in the 
Design Scale Factor box, which allows you to adjust the size of the pattern as a multiple of the 
image size. The default value (1.0) means the embroidery file size will be the same as the 
image size you are editing. The aspect ratio (width-to-height ratio) of the sewn pattern will 
be the same as that of the image regardless of the value of the scale factor. You can choose 
the minimum number of stitches to be sewn in any color block (the default is 10). 
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After saving the stitches to the embroidery file, you may continue editing the image or 
adjusting the pattern parameters in the stitch list. If for any reason you decide to end your 
stitching session, click the End Sew button. If you have made any changes to the stitch list, 
you will be asked to save them at this time.  
 
If you save the pattern and stitch list, the next time you open the image file in SewArt you 
will have the option to read in that information to continue further editing of the stitches, as 
described below. 
 
Congratulations! You have now converted your image into an embroidery file!  
 
Once you have created the stitch list as described in step 1 above, and before proceeding to 
saving it as an embroidery file in step 2, you may want to edit the stitch list. Editing can also 
be done after the image conversion is complete and you have viewed the image in an 
embroidery editor. If for any reason you want to modify the embroidery file you created, just 
reload the stitch list into SewArt and apply some (or all) of the editing features described 
below. 
 
Choosing the starting point ("seed") for sewing 
When you click the left mouse button, the tip of the "sewing needle" cursor defines the 
starting point (seed) from which SewArt will fill that region with stitches to match the image 
color. A judicious placement of the seed will minimize jumps in the final stitching.  
For example, it is advisable to choose an extremity of the region - far left or right, top or 
bottom - so sewing can proceed in one direction only. You should never choose a seed in 
the middle of the region! To obtain the best sew outs, the thread should flow in one 
direction for each section (region) of the embroidery design. For a region, click the tip of the 
"needle" cursor at the farthest point perpendicular (at right angles) to the chosen stitch 
angle. Sewn regions (see the beanie-cap of the penguin figure above) are identified as 
showing shaded "threads" instead of a solid color fill.  
The illustration below (taken from an embroidery editor, not from SewArt) shows the seed 
point as the red dot (where the tip of the needle cursor was clicked). The cursor was clicked 
at the farthest point and at 90 degrees to the angle chosen in SewArt (a 45 degree angle was 
used for this example.) The underlay stitches at 90 degrees to the chosen angle. Note that the 
embroidery stitches flow away from the red dot (seed point) in one continuous direction to 
the other side of the region.  
 
.  
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Often the recommended angles to use are the diagonals (45 and 225, or 135 and 315 
degrees) which avoid the weaker points at the top, bottom and sides of the hooped fabric 
where the fabric is more likely to give (pull away from the hoop). However, other angles may 
be more appropriate when trying to produce a textured appearance (for example, similar 
objects arranged on an arc). 
Different sides of an odd-shaped region should be tested to find the best angle to use. Use 
the resew option (see below) to restitch as required. 
After the clicked region has been sewn, continue to click on other regions of the image until 
all parts of the image you want in your final embroidery pattern are "sewn" in this manner.  
 
Pattern Fill 
Click on the scroll arrow of the pattern fill combo box to select a fill pattern to use for the 
satin stitch. This will drop-down a list of available fill patterns to choose from. Use the up-
down arrows to scroll through the patterns. An image of the selected pattern will appear 
next to the fill list. Click on one of these patterns to make it the active pattern that will be 
used the next time an area of the image is stitched. 
 
Edit the Stitch List 
At any time during the stitching process, you may edit the values in the stitch list (such as the 
stitch angle, length, underlay and fill settings). Just click on the item in the list and type in the 
modified data. Tabs and arrow-keys can be used to easily navigate through the list to the 
item(s) to be edited. For example, suppose you stitched the pattern initially so that all 
stitches are at the same angle. Before the final pattern file is saved, you can change angles for 
different parts of the pattern. To do this, click on the appropriate angle entries in the stitch 
list and edit them by entering the desired values. Note that angles are measured from the 
horizontal line (which is the default, or 0 degrees). Thus, an angle of 90 degrees corresponds to 
stitches in the vertical direction. 
 
Helpful hint: 
A contiguous range of stitch property values can be changed to the same value by clicking 
one of the header buttons at the top of the stitch list. For example, suppose the image was 
stitched with Underlay on (checked) for all parts of the pattern. But there are some thin 
outlines in the image  that do not require (and indeed should not have) underlay. Click on 
the U-L (underlay) column header button and a dialog box will pop-up allowing you to enter 
the range of color stop numbers, and the value (either "Y" for underlay, or "N" for no 
underlay). Clicking OK will then automatically change all the underlay values in the entire 
range. 
 
Delete, Resew or Insert Color Stops 
To see which sewn region of the image corresponds to one of the color stops in the stitch 
list, click that color stop button to highlight (in the inverse color) the associated part of the 
image. A pop-up menu will appear with options to Delete that color (from the stitch list, not 
from the image), or to Resew it, or to Insert another color stop before an existing one. 
Resew may be useful, for example, in the case when you have changed the stitch angle. To 
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see the effect of that change, click the Resew option for that color stop. This will clear the 
stitches from the associated region in the image. Re-click on the region to sew it out at the 
modified angle. If the insert (before) option is selected, a "blank" black color block will be 
inserted before the active color stop. The next image area that is clicked will be placed in that 
position in the stitch list. This may be useful if you want to add a particular part of the 
pattern somewhere other than at the end of the stitch list.. Ignore this pop-up (by clicking on 
the Close menu option) if you do not want to perform any of these operations. 
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Options Menu 
se these menu items to apply set various viewing options in SewArt. 
 
 
 

 

Units 
Use this menu item to choose between metric and Imperial (American) units of measure in 
SewArt. 
 

Parity 
Use this menu item to choose between left-handed and right-handed tool cursors in SewArt. 
 
 

Chapter 

7 
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Windows Menu 
se these menu items to view open Windows in various configurations in SewArt. 
 
 
 

 

All Windows 
SewArt displays a list of currently open document windows at the bottom of the Window 
menu.  A check mark appears in front of the document name of the active window.  Choose 
a document from this list to make its window active.   
 

New Window 
Use this command to open a new window with the same contents as the active window.  
You can open multiple document windows to display different parts or views of a document 
at the same time.  If you change the contents in one window, all other windows containing 
the same document reflect those changes.  When you open a new window, it becomes the 
active window and is displayed on top of all other open windows. 

 

Cascade 
Use this command to arrange multiple opened windows in an overlapped fashion.  
 

Tile 
Use this command to arrange multiple opened windows in a non-overlapped fashion. 
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Help Menu 
se these menu items to access help about SewArt. 

 

 

Help Topics 
Use this command to display the opening screen of Help.  From the opening screen, you can 
jump to step-by-step instructions for using SewArt and various types of reference 
information.   
 
Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen. 
 

About SewArt 
Use this command to display the copyright notice and version number of your copy of 
SewArt. 
 

Order Information 

This provides a link to the our website URL: http://sandscomputing.com for ordering 
SewArt, as well as other information about the application. In the commercial version, the 
batch conversion utility is fully enabled, allowing unlimited numbers of files to be converted 
and saved at once. 
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Digitizing Topics 
se this to find specific information (How to’s) about SewArt. 

 

 

Avoid Sewing Background 
To avoid sewing the background, use the bucket fill tool to flood the background part of the 
image with a transparency color that will not be sewn. Use the interactive color mixing feature 
of the bucket fill to select a unique color not in the image pattern. Alternatively, if you have 
checked the Auto-sew Image box on the Stitch Toolbar, then a drop down list will appear that 
allows you to chose either to sew all colors or to click on an image color that will be treated 
as transparent (not sewn). 
 
Otherwise, simply avoid clicking on the background color and it will not sew-out. If you 
click it by mistake, you can delete it from the stitch list before the actual pattern file is 
written. 
 

Blank Canvas 
When SewArt opens, the workspace contains a 100 X 100 mm image called a blank canvas. If 
you want to create your own artwork to sew, you can use the paintbrush, pencil and bucket 
tools to draw and color images on the "canvas". You may save your artwork and convert it 
to stitches like any other image. 
 
The balloon below was created (by someone with limited artistic ability!) using the 
paintbrush to create a solid red ellipse. Note that when "writing" on the blank canvas, all the 
colors are inverted by default, until you uncheck the inverse color button. This is done to allow 
you to write with a black pen or pencil on a white canvas. Next, the pencil tool was used to 
create a green free-hand string for the balloon. 
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Change Fill Pattern 
When in Stitch Mode, click the Fill scroll arrow on the stitch toolbar to open the pattern 
selection drop-down list. A bitmap of the presently selected pattern (the one showing in the 
edit box) will be displayed. Use the up and down arrow keys to scroll through the list of 
available pattern fills. Every time a new pattern is selected (highlighted in blue), its bitmap 
will be displayed next to the drop-down box. To select a pattern to use for filling, click on it. 
This will close the list and the name of the selected pattern will appear in the edit box. 
 
If you decide at any time to change the pattern for a region (color stop) of the image, you 
may edit the number associated with a pattern file in the stitch list. 

Change Color of Paint (or Pencil) Tool 
When one of the painting tools (pencil, paintbrush, or paint bucket) is active, its color may 
be changed in one of several ways: 
 
1. hold down the Control key and click the tool cursor over the part of the image 
whose color you wish to use 
2. click the normal (arrow) cursor on a color on the palette tool bar which appears at 
the bottom of the screen when one of the paint tools is active 
3. click the "eye dropper" button. This will cause the cursor to change into an eye-
dropper when you are over the image, and click the eye-dropper on the color you wish to 
use 
 
For the paint bucket tool, you can mix a custom color with the color picker tool. 
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Remove Speckles from an Image 
Most raster images - represented by formats such as  *.bmp, *.jpg, *.gif, *.png, *.tif - will 
require some image processing before they are suitable for sewing a high-quality embroidery 
file pattern. 
 
Most vector images - represented by formats such as *.emf, *.eps, *.wmf - already have 
performed some type of image processing and may not require further processing before 
being sewn. 
 
What determines when an image is suitable to be sewn? The simple answer is that all the 
visible (large-scale) colored regions are comprised of single colored pixels and there are very 
few (or no) speckles in the image. 
 
 What are speckles? 
Digitized images very often display some color aliasing at boundaries between different 
colored regions. This aliasing effect introduces a mixture of differently colored pixels in a 
thin (usually only a few pixels wide) boundary region between the different solid colored 
regions. These pixels - referred to here as speckles - are generally disconnected from one 
another and would lead to a very unpleasing sew-out if they were each stitched separately. 
(The needle would skip around from speckle to speckle, rather than sew in a nice smooth 
solid fill!) 
 
To view speckles with SewArt, open an image file and after reducing the color number if 
possible (without altering the image quality), click on the merge colors button. The example 
below is taken from a logo file that was downloaded with the permission of the embroidery 
website's owner: 
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Note that while there are only five solid areas clearly visible in the logo file (not including the 
white background), after color reduction there are still 16 colors remaining. Consider the 
red-hue buttons in the second row. Clicking on the first two shows their contribution to the 
logo image below: 

 
The figure on the left was generated by clicking the red color button (labeled 7.44% for the 
percent coverage that this color contributes to the image), and the figure on the right is the 
result of clicking the next (1.33% coverage) button. On the left are several solid areas of red. 
However, on the right are only speckles - occurring at the boundary between the red regions 
on the left and the background white region - which would lead to a disconnected, low-
quality sew-out if they were sewn, due to the chaotic jumping of the needle from point to 
point. 
 
How to eliminate speckles 
 
There are two types of speckles that require somewhat different handling. The first type is 
shown In the (right) figure above, where all the points are speckles  To improve the logo 
image quality, it is necessary to merge the speckles with the appropriate solid region color(s). 
In this case, by clicking consecutively all the red hue buttons, it is easily determined that they 
too are all boundary point speckles (except for the 7.44% case). To merge the speckles with 
the dominant solid red color, Shift-click each color button corresponding to red-hue 
speckles (one at a time), and then click on the 7.44% button to merge with it. Each time a 
merge is done, you will notice that the initial 7.44% coverage percentage will increase until it 
reaches 10.67%, as shown below: 
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Note that the color number has now been reduced to 12 and that the single remaining red 
color is almost free of speckles.  
 
This demonstrates the second type of speckle that occurs in practice, where most of the color 
is a solid region and now only a few speckles remain. In this case, one should not merge this 
color since that would also recolor the solid regions, which are desirable to retain in the final 
image. The remaining speckles can now be removed by clicking on the red color button (to 
highlight the red part of the image) and pressing the despeckle button. The figure below shows 
the result after of this despeckling operation. Notice the complete removal of the speckles 
around the needle and thread, while the solid red regions have been left intact. (Should a 
small number of speckles still remain, they could be efficiently removed with the pencil or 
paintbrush tools.) 
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Resize or Change Density of an Embroidery Pattern 
After you create an embroidery file with SewArt, it is possible to change the size, stitch 
density, fill pattern and/or angle. 
 
Important note: If you want to preserve the stitch order of a previously-sewn pattern, do 
not resize the image file (or the stitch list will be cleared!) It is much easier to resize the 
pattern when you save it (as described below). Here is the simple procedure for editing the 
embroidery file: 
 

Reopen the image file and click the "Convert" (sewing-machine) icon on the main 
toolbar.  This will get you into Stitch mode. You have the option at this time to reload 
the previously stitched embroidery file associated with the image. Then follow the 
directions for editing the stitch list, which are given in the Conversion section. In 
particular, to change the density, change the value of the separation settings. If you 
want to change the separation values for all the color stops, it might be easier to clear 
the stitch list, set the desired separation value on the sewing toolbar, and then resew 
the entire pattern. Finally, click the File/Save As menu item. Here is where you can 
choose to resize the pattern sewn, by entering a scale factor value (1.0 means no 
resizing, 2.0 means double the size, 0.5 means halve the size, compared to the 
nominal image size). 
 
 

In addition, you may edit the embroidery file in a separate embroidery file editor. 
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Toolbars 
se this to find specific information about SewArt toolbars. 

 
 

 

SewArt (Main) Toolbar 
The main toolbar (shown below) is displayed across the top of the application window, 
below the menu bar.  The toolbar provides quick mouse access to many image-processing 
and stitching tools available in SewArt. 
 
The magnifier glass is a toggle button. This means that once it is clicked, it appears in a active 
state (looks like it is pressed-in) on the toolbar until it is clicked a second time. While 
depressed, the cursor will appear as a magnifying glass over the image. 
 
The five right-most toolbar buttons are also toggle buttons. Unlike the magnifier button, 
these are mutually exclusive which means that only one of these buttons can be active (pressed-in) at 
the same time. Thus, when you click one of them, and another button in this group is 
already pressed-in, then that button will be cleared first before the new button becomes 
active.  
 
 

 
 
 
To hide or display the main toolbar, choose Toolbar from the View menu (or press ALT+V, T). 
 
 
Click To 

 Open a new empty blank canvas. 
 

 Open an existing image file.  SewArt displays the Open dialog box, in which you can locate 
and open the desired file. 
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 Save the active image and stitch file with its current name.  If you have not named the image, 
SewArt displays the Save As dialog box. If you are in stitch-mode, then the embroidery file 
and stitch-list file will be saved instead. 

 

 Undo the previous operation. 
 

 Paste the image file stored in the Windows clipboard into the active window. 
 

 Magnifying glass to zoom-in on a particular region of the image. 
 

 Enlarges view on screen (zoom-in) without changing image dimensions. 
 

 Decreases screen size (zoom-out) without changing image dimensions. 
 

 Rotate image 
 

 Resize image 
 

 Crop Image (remove parts of the image not included in stitch pattern) 
 

 Start the image-processing wizard. 
 

 Reduce number of colors in image 
 

       Merge and despeckle colors in image 
 

 Paint brush to fill parts of an image with a solid color 
 

 Pencil to fill individual points or lines in the image 
 

        Paint bucket to fill large regions of the image uniformly 
 

 Convert image to redwork 
 

 Opens stitching mode to convert a graphics image to an embroidery file. 
 

 Context sensitive help. 
 

 Help for individual selected items. 
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Stitch Toolbar 
The stitch toolbar is displayed across the top of the workspace when Stitch Mode has been 
activated by pressing the Convert to Stitches button on the main toolbar. There are two 
types of stitch toolbars described below which appear depending on whether the mode is for 
filling or outlining the image. 
 
 
Fill/Outline Stitch Mode Toolbar 
 
This bar is split into two separate toolbars (see figure below). One of the bars displays tools 
for editing pattern properties (like underlay, fill or outline style), while the other has tools for 
setting thread properties (like thread separation). Both can be moved to other positions in 
the workspace by clicking and dragging the grab-bar at the left of the toolbar.  
 
These toolbars provide quick mouse access to features used to sew out the pattern file 
corresponding to the current image in the SewArt workspace. 
 
 

 
 
 
The content of the drop-down combo box shown above in the top toolbar changes 
depending on the fill style that is selected. When the Fill radio button is checked (as shown 
above), then the combo box contains the pattern fill styles that are available. Click on the 
down scroll arrow to open the combo box. Use the Up/Down Arrow Keys on your keyboard 
to scroll through the list of available patterns and to display an image of the pattern. This is 
the ONLY way you can scroll and view the pattern images (if you use the scroll bar on the 
combo box, you will not see the images appear!) In the example below, the #19 diam01 
pattern is highlighted by pressing the Down arrow key, and the pattern appears to the right 
of the combo list. Once the desired pattern is found, click on it with your left mouse button 
to select it and close the combo list. 
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When the Outline option is checked, the combo box will be filled with the three available 
outlining stitches (see the figure below). Again, scrolling with the arrow keys will give a 
depiction of the stitch layout. In Outline mode, the Separation control label (shown in the 
toolbar above since Fill is checked) changes to Satin Height and the Angle control becomes 
inactive. 
 
 
Click                    To 
Fill/Outline Radio Select stitch mode (either pattern fill or outline stitch) 
 
Fill/Outline Combo Box Open a drop-down combo box for selecting pattern fills or outline stitches 
 
Underlay Check Box Add (checked) underlay stitch to the pattern 
 
Auto-sew Color  Automatically sew ALL the same colors (as the one clicked) in the image 
 
Auto-sew Image Automatically sew the entire image.  
 
Separation/Satin Height Set the density of the fill (in fill mode), with.lower separation translates to higher 

density. In outline mode, set half-height of satin outline stitch 
 
Length  Set the average stitch length for underlay. 
 
Angle  Adjust the stitch angle of the fill (horizontal fill corresponds to 0 degrees) 
 
 

 
Redwork-Stitch Mode Toolbar 
 

This toolbar appears automatically when the Redwork toolbar button has been clicked, 
indicating that the image has been previously converted to outlines or center-lines: 
 
 

 
 
 
Click                    To 
Stitch Type Combo Select either a running, bean, or stitch for the outline 
 
Length               Set the average length for the stitch (default is 1.0 mm) 
 
Satin Height  Set the height for the satin stitch 
 
Sew Outline  Sew out the outline on the screen (preview) before saving the stitches 
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